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Chapter 1
Introduction to Myfriend

WHAT Is Myfriend?

Myfriend is a portable device designed for work, study and leisure time.

Thanks to its wide high definition display, Myfriend is ideal for reading Microsoft Reader LIT
eBooks.

Based on Microsoft Windows CE 3.0 operating system, Myfriend has a built-in modem,
allowing users to either navigate the Internet with the use of the Microsoft Internet Explorer
browser, or send and receive emails.

The built-in microphone located on the front alows you to record voca messages, while the
speaker makes it possible to listen to audio MP3 files.

Myfriend FOR WORKING

Myfriend is an ided device for the immediate use of manuals, dictionaries, guides, codes,
graphics, and documents. Texts and hypertexts can easily be updated through the Internet, and all
thisis available into a small portable device.

Myfriend FOR STUDYING

With Myfriend you will always have at hand dictionaries, encyclopaedias, educational material
and notes with the use of advanced search functions. The built-in speaker can be of great help in
order to learn aforeign language. All this can be found in just one device.

Myfriend FOR LEISURE TIME

Myfriend is a simple and practical device that can be used during leisure time, at home or
travelling. With Myfriend you can take your favourite books and magazines anywhere you go,
play games and listen to music in your moments of relax.

Error! Reference source not found., Page 5



PACKAGING CONTENTS

The package contains the following items:
v Myfriend
v" One back-up stylus
v' AC adapter
v “Firgt time user” guide with Cd-ROM

The device is shipped in protective packaging. Save and use for transporting or long-term storage
of the unit.

Chapter 1
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Chapter 2
A closer look at Myfriend - Hardware

FRONT VIEW

Chapter 2
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© pisplay
The Myfriend liquid crystal display (LCD) is an example of high quality technology. The 7,5”
high definition display makes both reading eBooks and using the device an enjoyable experience.

The Portrait mode emulates the proportions of a book, making Myfriend even more user
friendly.

Thanks to its high quality colour technology, the display supports more than 65 thousand
colours, making Myfriend the ideal device for viewing images and graphics.

Myfriend display is Clear Type compatible, a technology adopted by Microsoft Reader to offer
the best reading experience possible on aliquid crystal display.

© Microphone

Using the built-in microphone found on the front right hand side of Myfriend, you can record
vocal messages.

Myfriend is designed to perfectly record al sounds within 25-30 cm, the normal reading
distance. To record voice, you just have to speak with a natural voice at this distance.

© Rocker Switch

The Rocker switch implements some functions already present on the keyboard which appear on
Myfriend’s display. It can be used in place of the arrow keys Up, Down and Enter.

To activate the functions of the arrow keys Up and Down, move the Rocker switch up or down.
To activate the function Enter, just press down on the key.

O pPower On/Off

Power on/off starts or puts the device on standby.

To turn on the device, just press the key once and after less than a second Myfriend is ready for
use.

To turn off the device, keep the key pressed for at least 3 seconds. Once turned off, Myfriend
will store the last screen, so when it is turned on again this will appear.

Ay

BN
N2 Turning off Myfriend may cut off the connectionsin progress.

Chapter 2
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Tor VIEW

© Modem
The 56K built-in modem allows you to navigate the Internet and download emails.

To connect, plug into Myfriend the RJ11 connector of the telephone cable that is already
connected to the telephone socket.

® USB (Universal Serial Bus)

USB dlows Myfriend to establish communications with a desktop PC and other devices. A
USB cable (not included) is needed for this purpose.

©® pcmcIA

External removable storage media such as Memory Cards, PC Cards, GSM and GPS devices,

can be added to expand Myfriend’s functiondity.
\/éf

/XibNote! For some PCMCIA cards it is necessary to check the
availability of the Windows CE drivers.

O DA
IrDainfrared port allows for awireless connection of Myfriend to alaptop or desktop PC.

Chapter 2
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© Earphones

Plug-in the earphones into the jack.

~ N~ Caution! To avoid injuries, turn down the volume before wearing
headphones. When earphones are plugged-in, the speaker is
disconnected.

(G Stylus
Lodging for the stylus.

Chapter 2
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BotToMm VIEW

© Power Supply

Allows you to connect to AC power through the AC adapter included in the package.

P
/\‘\i’i‘b When light near the jack is turned on, the internal battery is being
in recharging.

P
/N"blt is possible to use Myfriend while recharging the internal
battery.

® Reset Button

The reset button can used in case the software crashes.
To reset the device, press the button by using the tip of the stylus.

© Serial port
Allows you to establish communications with peripherals or to a PC.

O smart Card Reader
A dlot designed to insert a smart card in SIM format.

© smart Media
A dlot designed for Smart Media memory cards.

Chapter 2
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BACK VIEW

O speaker

Designed to listen to music and sounds.

(2 Battery switch

Activates or deactivates Myfriend’sinterna battery.

To activate the internal battery, move the switch down by using the tip of the stylus. Moving the
switch up deactivates the internal battery so that Myfriend is able to work only using the externa
source of power.

e
/7‘52"\ Caution! If not absolutely necessary, do not deactivate the main
battery because all data will be lost. Always try to reset the device as

previously described.

Chapter 2
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Chapter 3
Getting Myfriend started

THE STYLUS

The stylus is used to select commands by tapping on Myfriend’s touch screen. The stylus is an
ideal tool to execute commands precisely and efficiently.

The sound made by the stylus when touching the screen corresponds to the “click” of the mouse.
The stylus can be used to select icons or input data into the device:

1. to select, drag the stylus on the display;

2. to view the options, tap and keep the stylus pressed on the desired icon.

In a short time you will see how easy and fun it is to use the stylus.

FEEDING AND RECHARGING BATTERIES

AC Adapter

The AC adapter can be used either to recharge the battery or to work with the device connected
to AC power.

When the yellow light near the jack is turned on, charging of the battery isin progress.

Start Up

P
. “”35‘ Before turning on the device, control that the battery is charged
or that Myfriend is properly connected to AC power.

A few simple, effective and safe steps are needed to start up Myfriend.

Simple, within the first few minutes you will perfectly know how to use Myfriend.
Effective, with a few tabs you will calibrate the touch screen, customize functions and set date
and time.

Chapter 3
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Safe, because you just need to follow the set up wizard to customize and make the most out of
your Myfriend.

Before you can use Myfriend, you first need to:
turn on Myfriend by gently pressing the Power on/off button;
tap on the display to calibrate the device;

on the display a target will appear, carefully press the stylus on the centre of the target
and repeat as the target moves on the screen;

tap again on the screen to end calibration;
set date and time;

set owner information.

P
/Nf\) Such information are not mandatory and can be modified anytime
by selecting: Start - Settings - Control panel - Owner.

tap again on the screen to end calibration.

Chapter 3
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Chapter 4
A closer look at Myfriend - Software

OPERATING SYSTEM

Once started up, Myfriend offers a user friendly interface thanks to its operating system which
issimilar to Microsoft Windows on a PC desktop.

Microsoft Windows CE 3.0

Microsoft Windows CE 3.0 is an operating system designed so that PDAs can share data with
PCs and connect to the Internet.

Desktop

The icons on Myfriend’'s desktop are the same as those found on any desktop PC: My
Computer, Recycle Bin, Internet Explorer as well as the Start button located at the bottom left hand
corner.

The Desktop icon is located at the bottom right hand corner and on its left other icons can be
found.

v" Input Panel - to open the built-in keyboard to input data;
v" Power Status - displays the current power source;

v" Time.

Start Menu

The Start Menu contains the following functions:

Programs alist of the installed programs

Favorites alist of web pages contained in the Favourites folder
Documents alist of the last 10 documents used

Settings contains Control Panel and TaskBar
Help on line user’s guide to Windows CE
Run... launch of programs and opening of documents by specifying their path

Chapter 4
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Suspend to turn off Myfriend either tap on Suspend or press the Power on/off button

Control Panel

Allows you to modify Windows CE default settings.

To open the Control Panel double tap on the My Computer icon or select Start — Settings —
Control Panel. Once you have opened the Control Panel, select View - Details

Backlight

This function allows you to set the display’s brightness. To open this window, double click on
the Backlight icon.

To set the brightness of the display, adjust the slider to fine-tune the settings for this purpose,
then tap on Apply to enable the new settings.

Communications

Through this window is possible to configure a PC connection and to setup the type of
connection to be used.

To open this dialogue box, double tap on the Communications icon.

To configure the connection to a PC, select PC Connection within the Communication
Properties menu. The function Allow connection with desktop computer when
device is attached must be selected, for this purpose tap on the Change button and choose the
desired connection within the drop-down menu.

Py

TNED g you cannot find the desired connection in the drop-down menu,
you can create a new one through: Start - Programs — Communication
Remote Networking.

The Device Name tab within the Communication Properties window, allows you to
modify the name used when identifying your device from other computers. In the Device Name
dialogue box, type in the name of your device without spaces and in the Device description
dialogue box, type in a brief description.

Date/Time

To open this window double tap on the Date/time icon.

The Date/Time window is user friendly. The month and year set by default appear on the top
left hand side, to change them, tap on the arrows on either side of the month shown. To change the
date, select it in the calendar.

Chapter 4
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The time setting appears on the top right hand side, below you will see the drop-down menu to
set the time zone.

To set the time use the Input Panel or drag the little arrows near the value for time.

To set a different time zone, select it from the drop-down Time Zone menu.
To activate the daylight savings time, select it from the menu.

To enable the new settings, tap on the Apply button and then OK.

Dialing
To open this window, double tap on the Dialing icon.
Through this function you can use Myfriend’s built-in modem to connect to the Internet.

Modifying the setting of the Dialing Properties menu, you can configure the Dialing L ocation that
IS the connection to the telephone network.

Y ou can set up as many Dialing L ocations as you need, for example to dia up from work, home
or while travelling.

The Diaing Locaion corresponds to the place you are calling from. For example, if you are
calling from a hotel, the number you dial will have to include the number of the switchboard. If you
travel alot for work, it is possible to configure different dialling locations for each city and country.
It is adso possible to set up a dialing location that is not necessarily associated to a specific
geographical area. For example, it is possible to create various dialling parameters using different
phone cards or telephone conpanies.

To modify the Dialing Location, select the desired country and area code, then type in or modify
the prefixes for calling and finally select the desired options near the Dial box.

To set up a new Dialing Location, tap on the New button, type in the desired location using the
Input Panel and then tap on OK.

The Dialing Patterns option opens a dialogue box where it is possible to configure the number
that will be dialled. This function is necessary in order to create a remote connection to | SP devices.
Y ou need to select the letter G in the boxes for Local, Long Distance or International Calls.

To deactivate the call waiting system, select the deactivate Call Waiting menu and choose the
correct number sequence in the drop-down menu or type in a new one using the Input Panel.

Display

This function allows you to modify the backlighting, select a background image and theme for
your desktop.

To open this window, double tap on the Display icon.
Within the Background tab, select the Image you want as the background of your desktop.

To locate an image in another folder, select Browse. If you want the image to cover the entire
desktop, select Tile image on background.

The Appearance tab allows you to select a colour for each setting.

Chapter 4
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The Scheme drop-down menu alows you to select 13 different colour schemes which can be
immediately viewed on the Apply button.

Myfriend allows to create a customised colour and store it.

The drop-down Item menu alows you to select the item desired and change its colour by
tapping on the button found on the right.

By tapping on the Apply button, you can immediately view the result. Once you have selected

the desired colour, tap on Save and a dialogue box will open: type in your name of choice for the
colour scheme you have created.

Using the Backlight tab, you can set the display to dim after a certain time. You can tick one
of the two following options:
v Automatically turn off backlight while on battery power

v Automatically turn off backlight while on external power

Once you have specified the amount of time, the display will dim automatically.
Then tap on OK.

I nput Panel

It allows you to set the Input Panel feature.
To open this window double tap on the Input Panel icon.

The Options settings alows you to type in faster. To open this application double tap on the
Options button and the Input panel Properties dialogue box will open. Enlarging key size
will in turn enlarge the key size, making it easier to type.

The keys not only respond to the Stylus taps pressure, but also to its movements. The device
responds in different ways to the dragging of the Stylus outside the key while keeping it on the
screen:

v Dragging upwards =>  capita letter;
v Dragging rightwards =>  gpace

v Dragging downwards =>  enter;

v Dragging leftwards =>  backspace.

This function makes it easier to type in data.

Keyboard

To open this window double tap on the Keyboard icon.

Keyboard properties allows you to configure both the Repeat rate and Repeat Delay. Ticking
the Enable character repeat box activates two optiors:

v" Repeat Delay alows you to set the amount of time between the Stylus
taps before repetition starts;

Chapter 4
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v" Repeat Rate alows you to modify the amount of characters written in
one tap.

Then tap on OK.

Network

This function alows you to change the settings of the network drivers installed in your device
and to gain access to network resources.

To open this application double tap on the Network icon.

N f*‘%"
SN L

N~ Because most servers use the DHCP protocal, it is not
necessary to change the default settings.

Owner

To open this window double tap on the Owner icon.
The Owner Properties window includes two tabs: Identification and Notes.

When the Identification tab is selected, you can type in Name, Company, Address as well
as your phone numbers.

If you tick the Display Owner ldentification box, this information will be displayed when
you turn on the device.

You can use the Notes tab to add any additional information not included in the User
Identification. If you tick the Display user notes at power on box, this information will be
displayed when you turn the device.

Then tap on OK.

Password

This function alows you to provide Myfriend with a password-based security system to
prevent unauthorised access to your device.

To open this application double tap on the Password icon.

To set the primary password, type in four numbers of your choice both in the Password and
Confirm dialogue box, then select the Enable Password Protection box, finally tap on OK.

Power
The power application displays information about the current state of the device's battery and
allows you to configure an automatic power-off of the device to preserve battery charge.

Chapter 4
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To open the Power application, tap on Start - Settings - Control Panel and then double tap on
the Power icon.

To open the Power Properties screen, double tap on the Power icon, then you can choose one of
the following options by adding atick sign:

v Auto-suspend the device while operating on battery power
v Auto-suspend the device while operating on AC power

Then choose an idle time value from the drop-down box. After the specified amount of idle time,
the device will auto-suspend.

Pt

/Nﬁ" When battery power is low, a message will appear on the screen

and the corresponding icon will be shown on the bottom right hand side
of the toolbar. Just double tap on it to open the Power Properties
dialogue box.

If Myfriend turns off because the battery is dead, you have three days to recharge battery
without losing any data. Until you recharge the battery you will not be able to use Myfriend.

Regional settings
This function alows you to modify numbers, currency, date and time.

To open this window double tap on the Regional Settings icon and the select the tab for the
type of information you want to change.

P
/N,\) The features available depend on the language sel ected.

Stylus

To open this window double tap on the Stylus icon.

v' The Double-Tap alows you calibrate tap speed. With Myfriend you
can preview the results and if necessary modify the changes,

v" The Calibration tab allows you to recalibrate your screen (as occurred
during start up). This allows you to customise tap accuracy.

To start, tap on Recalibrate.

Recalibration involves tapping the centre of a target which will appear five times on the screen:
in the centre, on the upper left hand side, the lower left hand side, the lower right hand side and
the upper right hand side.

Finally, you will have 15 seconds to tap on the screen and confirm recalibration. If not,
recalibration will be automatically terminated and data not saved.

Then tap on OK.

Chapter 4
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System
To open this window double tap on the System icon.

The System tab contains information on the operating system, the computer and registration
data

The Memory tab allows you to adjust the available RAM memory.

Y ou can alocate unused RAM to Storage Memory or Program Memory according to your
needs. Just move the dider to the right to allocate more memory for storage or to the left to
allocate more memory for programs.

Then tap on OK to save settings.

Volume & Sounds

To open this window double tap on the Volume and sounds icon.
In the window Volume & Sounds properties we have two tabs: Volume and Sounds.

The Volume tab alows you to set the volume of sounds and activate event sounds. On the left
hand side of the Sound tab, an Event name list can be found, it is possible to give each event a
different sound. A speaker icon marks the events matched with a default sound.

Selecting an event from the Event name lig, it is possible to match it with a sound from the drop-
down Sound event list.

You can tab on Browse o select new sounds (in .wav format) either in the folder or memory

card. Tapping on Play » and Stop '™ you can listen to the sounds. In the drop-down Scheme menu
you can choose one of Myfriend’s default schemes and by tapping on Save As you can save
customized schemes.

Chapter 4
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Chapter 5
Internet Options

Using Myfriend you can exchange information with another device, PC or the Internet. To
create a new connection you must configure Myfriend through: Start - Programs -
Communications - Remote Networking.

CONNECTING TO AN INTERNET SERVICE PROVIDER (ISP)
To surf on Internet you must be connected to an Internet Service Provider (ISP), and to do this,
the following information is needed:
v" ISP phone number
v' ISP registered user name
v’ password

Once you have activated the connection you can send and receive emails and surf on Internet.
B

~ N~Before using remote connection to connect to an ISP you have to

modify the Dialling Number, refer back to Dialing.

Create a connection

On your desktop double tap on Make New Connection and type a name for the connection.

Select Dial-up Connection. Select the modem type by tapping on Select a modem.

Type in: Country code (if the access is international), local area code, Telephone number, user
name and password. Then tap on Finish.

Once the connection is created it appears on the Desktop or in Start - Programs -
Communications - Remote Networkings. To modify the settings:

v Tap on the connection icon;
v Choose Properties within the File menu.

This allows you to send and receive emails using Inbox and navigate the Internet using
Internet Explorer.

/\‘\V:S Before sending and receiving emails you need to set up an Inbox

mail service. Refer to * Set up an email service.”

Chapter 5
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Chapter 6

Software

BSQUARE BACKUP

Allows you to create a back- up copy of your data and to restore it if needed.

The Auto-Backup application allows you to carry out an efficient back-up.

Otherwise you can manually copy the data using the Options menu.

File

New Backup

Allows you to cancel al previous steps and starts over after you have
confirmed your choice

Open

Allows you to open the back-up file

Start Backup

Allows you to open the dial ogue box in which you can choose the name of
the file, the extension and the steps to follow. Using a password you can
protect the file. Tapping on OK, starts the creation of afile

Start Restore

It is activated when you have to restore afile. Double tapping on the back-
up file, adialogue box will open: on the left you can see the list of the files
and on the right how they will be restored

About Gives information about the programs and reference sites
Exit To quit the program
View

Changes how the file icons are displayed.

List Only displays the file list, name and tick box
Details Displays size, extension and date of modification
Selection Displays dl file information

Information

Chapter 6
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Tools

Select/Unselect

it alows you to choose the files to
be saved in the back-up copy

Backup Wizard

displays the steps to follow to
either back-up or restore

View log displays information about back-
up and restore results
Options opens the menu containing the

following tabs:

Preferences

Allows to Show/Hide file stored in
ROM, defining the extension or date to
be sat.

Back-up

General Tab:

Use data compression -
activates/deactivates the zipping of back-
up file to save space.

Verify Data when backup is complete
- checks that back-up is successful.

Advanced tab, select from the drop-
down menu:

Do not modify file's archive bit - if
you don’t want to change back-up data.

Mark backup file as archivied - to
include them in the copy

Unmark backup file as archivied - -
if you don't want to include them in the

copy

Restore

Allows you to solve problems if the
back-up data is the same as the system.
You can customise it if it is a file
database, or configurations data.

Logging

Allows you to define the log file
(which includes a list of the back-up
files).

Other

Allows you to activate/deactivate the
Auto back-up option when the program
Is launched. Enter the date and time the
back-up file was set up. You can aso
limit file size.
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BSQUARE BFIND

To open the program select Start - Programs — Bsquare BFind.

It has the same functions as the Windows Find application. It allows you to:

v’ search file by name,

v' search for text in afile, email message or a database.

The toolbar displays three buttons. Search, Results and Shortcut, each corresponding to a
different function.

Search allows you to search for a file, Results shows you the results of your search,
Shortcut displays where the file is stored on your computer.

Type in the word or words you are searching for in the Look for dialogue box on the right.
Select Search location on the left and tap on Search to start searching.

Ay

N2 you do not select an option bFind will not work.

The File menu has five options:

v
v

Use script

Use Tray lcon, allows you to place an icon corresponding to a program in the bottom
right hand corner of the toolbar (near the clock). To open the program double tap on the
icon.

Edit associations, alows you to combine an icon with a different program. (e.g. You
can combine the email icon with X-Audio Player).

About, alows you to view information about the computer company and the link to its
Internet site.

Exit.

Shortcut has seven options:

v
v
v

Add results, adds new search results to existing links.
Add last search, adds the last search to existing links.

Custom shortcut, alows you to add a link manually. Double tapping on it, opens a
window in which you have to type in the name of the file you want to link and the name
of the link. The original file will not be changed.

Delete shortcut, deletes al sdected links.

View Shortcut, opens the link. If it is a search result or a manual link the file will
open, if it isa search it will display the search screen.

Large Icons and Small Icons, allows to set theicons’ size.
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BSQUARE VOICE RECORDER

To open the application, select Start — Programs — Bsquare Voice Recorder.
It allows you to record vocal messages using Myfriend’s built-in microphone.

It is easy to use. It has a File and an Options menu and its functions are similar to those of a
tape recorder: play, pause, stop, rec, ffw, rew.

The File menu has five options:

v" Open, opens the Open file dialogue box to search for a recoring
stored in Myfriend,;

v Rename, alows you to rename a message;

(\

Delete, deletes a vocal message;

v" Properties, displays the properties of a message including: Name,
size, details.

Y ou will see avolume dider located below the menu and toolbar.

At the bottom of the screen, you will see a dider thet allows you to listen to different parts of the
message.
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MICROSOFT INBOX

Allows you to organise your emails. To open Inbox, double tap on the icon found on the desktop
or select Start - Programs - 1 nbox.

Inbox has four default folders: Deleted, Inbox, Outbox, Sent.

Emails will be stored in these folders. You can create new folders within the default one by
selecting File - Folder - New Folder, then type in a name and tap on OK.

Setting up your email service

Once opened the Inbox within the Services menu, select Options from the Services tab
and tap on Add.

In the Service Type drop-down menu, select the protocol type: POP3 or IMAPA.
In the Service Name box, type in the name you want to give to your account.
Then tap on OK.

In the Mail Service Definition diaogue box fill in:

v' Connection - either select the connection from the drop-down menu or create a new
one using Create new connection...

v' Server - enter the name of the mail server you use to receive and send emails (e.g.:
pop3.yourprovider.com).

v" User ID - enter the user name assigned to you.

<

Password - enter the password that you use to access this email account.

v" SMTP Host - insert name of the server to be used when sending emails (e.g.:
smtp.yourprovider.com).

v' Return Address, enter your email address.

To send and receive emails, you have to synchronise Myfriend with Microsoft Outlook on the
desktop computer or connect to an ISP email server.

Once you are connected, tap on the Send/Receive button or select Services - Send/Receive
from the menu.

Composing email messages

Tap on Compose and select New message from the drop-down menu.

Enter the address of one or more recipients in the To box, or select a name by tapping on the
Address book button found on the toolbar.

Compose the message using the Input Panel. To attach a file, tap on the Add attachment
button.
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Tap on Send from the File drop-down menu. The message is moved to the Outbox folder and
can be sent in the following ways.

transfer the message on a desktop PC and send it from here;
send the message from Myfriend.

Connecting to an email server

You can send and receive email messages by connecting to an email server through your
modem. For this purpose, you have to create a connection both to an ISP and to an emalil server.
Received messages will be downloaded in the Inbox folder while those found in the Outbox folder
will be sent and then moved to the Sent folder. The message you delete from your email server will
aso be deleted from the Inbox folder and vice versa

Message List

By default, messages are organised chronologically so new ones will be on the top of the list.

To open a new message double tap on it within the Inbox folder. Unopened messages are in bold
type.

By default, Inbox does not download attachments and only downloads the first 100 lines of the
message when you connect either to an email server or using PC synchronisation.
P\
"N The original copy of the message remains stored on the email
server or on the computer.

To mark the messages that you want to completely download during the next synchronisation or
connection to the email server, tap on the message and select Get full copy within the Services
drop-down menu. The message will be marked by a small icon.

To view the attachments you have to download the entire message. Attachmerts are marked by a
paper clip icon at the end of the message. Tap on the icon to open the attachment if completely
downloaded. Otherwise, it is marked and will be downloaded at the next synchronisation or
connection to the email server.

Organizing messages and working with folders
By default, messages are stored in one of the four folders: Deleted, Inbox, Outbox and Sent.
The Deleted folder contains the deleted messages.

To work with the Deleted and Sent folders, tap on the Services drop-down menu, sdect Options
and, in the Read tab, select the desired option, and tap on OK.

To create new folders to organise your messages, select File - Folder - New Folder from the drop-
down menu. To move or copy a message from one folder to another, tap on File and select M ove to
or Copy to.

Py
“NZYou can move or copy a message from one folder to another also

by dragging and dropping it in your folder of choice.
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MICROSOFT INTERNET EXPLORER

The Internet Explorer version installed on Myfriend is specially designed for its operating
system. It'sideal to navigate the Internet.

Y ou can view web pages either online or offline:

v online, you have to connect to an ISP (see Chapter 5: lnternet
Options);

v offline, you have to connect Myfriend to a desktop PC using a USB
cable or alrDA port (see Chapter 5: Internet Options).

To open Pocket Internet Explorer tap on Start - Programs — I nternet Explorer or double tap on
the icon found on the desktop. A dialogue box will appear asking you to confirm the connection.
Once connected, the program will search the page you have specified as your Home Page in the
Internet Options menu. To modify, select View — Internet Options.

The Internet Options dialogue box will appear:

v inthe Start Page box you can select your home page of choice. To set
a blank page as your home page, do not fill in this box.

v in the Search Page box you can specify the address of your favourite
search engine which will be viewed when tapping on Search or Go -
Search;

v in the Cache Size box you can alocate a section of your local storage
memory to temporarily store data, in this case Web pages,

v' ticking the option Use LAN, Myfriend will use one of the local
connections available;

v inthe Autodial name box you can select the default setting choosing
from the drop-down menu (to create a new connection see Creating a
connection);

v’ ticking on Access Internet using a Proxy Server box, will open
two other dialogue boxes which must be filled in to use a Proxy server.

Tap on OK to enable the settings.
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MICROSOFT POCKET WORD

Pocket Word allows you to create and edit documents just as you do in Microsoft Word on a
Desktop PC.

It allows you to read documents written on any desktop PC, to modify them or create new ones
using Myfriend.

PEiN
“NETo type text, you must use the Input panel. Refer back to Input
Panel

To open Microsoft Pocket Word double tap on the icon found on your desktop or select Start -
Programs — Microsoft Pocket Word, a document will open. To open other documents tap File -
New - Document.

To use a template, select File - New - Document from Template Then select the desired
template and tap an OK.

To open an existing document tap File - Open and the window My Documents will open. Tap
on the file name to open and then OK, or double tap on the name of the file.

Using Input Panel you can create new documents with Pocket Word. To use the Input Panel,
tap on the icon located on the bottom right hand corner of the toolbar.

To edit the text in a document, drag the stylus over it. Tapping on Edit, you can cut, copy and
paste the selected text.

You can adjust the paragraph alignment selecting Align left, Centre or Align right or by
selecting Format - Paragraph. Y ou can also create bulleted and numbered lists.

You can save the document in different extensions such as Pocket Word (.pwd), Word 97
Document (.doc), RTF Document (.rtf), Text only (.txt), etc.

Selecting Find or Replace within the Edit menu, you can search for the text inside a document.

To zoom the page in or out, select View - Zoom and select the desired percentage.
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POCKET ON-SCHEDULE

Pocket on Schedule works with other programs. It allows you to write emails and documents,
create folders to organise calendars and appointments and create databases.

FileMenu

New Contact...

Allows you to create a new contact and add it to the
Address Book. The contact to identify persona data such
as name and address. This option includes six tabs: Work,
Home, Phone numbers, Emails, Notes and Status

Work

Allows you to type in work data

Home

Allows you to add home address, birthday, set a reminder
for birthdays, spouse and children.

Phone
Numbers

Allows you to add various phone numbers. home, work,
assistant’s, home fax, work fax and pager

Emails

Allows you to enter up to four email addresses, web page
address which you can visit or write an email to

Notes

Allows you to add notes

Status

A summary containing: date of set-up, date of
modifications, author, folder and data base extension

New Activity

Allows you to add a new activity

Date

Allows you to set an interval of dates (starting and ending
date), time interval, place and object of meeting, view
mode (busy, available, out of office, try again), alist of
different options, reminder (a message set & acertain time
to remind you that you have an appointment and repeat it
daily if needed)

Recurring

Is it a one-off task or daily, weekly, monthly or yearly?
Y ou can choose from the following:

Once

Daily

Weekly

Monthly

Yearly

Notes

Allows you to add notes

Status

A summary containing: date of set-up, date of
modifications, author, folder and data base extension
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New Task

Main Allows you to enter the starting, due and ending date, work
status (selected by a drop-down menu), priority and project
name, progress rate, sub-status (including four tabs) and
reminder

Details It includes working hours, sub-project, version, sub-type,
category (see Contacts), the possibility to write emails,
owner (your email from the drop-down menu).

Recurring Isit aone-off task or daily, weekly, monthly or yearly?

Y ou can choose from the following:
Once

Daily

Weekly

Monthly

Yearly

Notes Allows you to add notes

Status A summary containing: date of set-up, date of
modifications, author, folder and data base extension

New Document

Main Allows you to enter aHTML document, assign an icon
among the four options and enter a keyword, author, time
and category. To enter the document, tap on Browse and
select the file of your choice

Notes Allows you to add notes

Status The option Folder defines the folder in which the document
you entered will be saved

New Notes

Main Allows to enter notes, date, time and select the colour the
colour of the icon that will distinguish this note from the
others.

New Journal
Entry

Main Allows you to select date, time and any file by tapping on
Browse and choose a category

Notes Allows you to add notes
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New Folder

Allows you to create a new folder within Myfriend’sMy
Documents’ folder or create a sub-directory within the
existing folder. In Folder Name type in the name the name
of the folder and then define if it afolder (called Group
Folder) or sub-directory

Go Menu
Previous folder |Allowsyou to return to the previous folder
Next folder Allows youto go to the following folder
Contacts Contains your list of contacts
Calendar Double tap on the desired date to enter a new task
Tasks Displays tasks
Notes Displaysicons set through New — Notes
Phone log Displays dialled numbers
Info center A ligt of the documents containing web pages

For more information on this program, please refer to the Help information provided with
Pocket-On Schedule.
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OpYSSEY QVP — Quick VIEw PLUS

To open, select Start - Programs- QVP.

It allows to view 225 different formats either documents or images. By using the stylus you can
open, print, copy, paste, zip afile and add it to an exiting database.

Thanks to this application Myfriend can view files created by different computers, programs or
different versions of the same program.

This application is easy to use. Once opened, you will see Myfriend’s memory displayed as a
tree diagram, organised in directories and sub-directories.

Double tapping, the selected folder or file will open. To return to the previous step, select View -
Show File Tree, or tap on the toolbar buttons.

The Rocker switch allows you to skip from afile to another, asif you were turning the pages of
a book.

Chapter 6
Software, Page 34



X-AUDIO PLAYER

To open this application select Start - Programs - X-Audio Player.
It allows you to listen to audio MP3 files with the following functions:
v Play ® afileor aplaylis,
v Add afileto aplaylist,
v" Combine two playlists,
v Create new playlists.

A Playlist contains alist of the music you want to play on your device. The application (player)
will play a piece of music one after the other according to the list order.

Random, plays music randomly.

Repeat, alows you to repeat a selected piece of music.
Program, alows you to play tracks in your favourite order.
File menu:

Open file, opens an existing file;

Open playlist, opens an existing playlist;

Add file, adds afileto the playlist;

Add playlist, combines a playlist to the current one;

NSERNERNERN

v' Save playlist, saves the current playlist in afile.

Through the Option menu, you can change default settings such as volume level and sound
qudity.
The following buttons will appear on the left hand side of the screen:

v' Delete, deetes afile from the playlist;

v" Open, opens the Open file window to search for a piece of music
stored in Myfriend;

Fast Forward, alows you to play the next piece of music;
Rewind, alows you to play the previous piece of music;

Repeat, alows you to replay a piece of music;

SSEENEE NN

Repeat playlist, alows you to replay the whole playlist.
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Chapter 7
Microsoft Reader

Microsoft Reader allows you to read eBooks. You can download eBooks directly from the
Internet to Myfriend or to your desktop PC and then copy them on Myfriend.

To open Microsoft Reader select Start - Programs - Microsoft Reader. You will then see a list
of books to choose from by tapping on the title of the book.

Microsoft Reader allows you to search for a specific text or a definition of a word, to copy or
highlight a part of a text, add notes, bookmarks and images.
PN
“NZ You can change font size by tapping on the title found in the upper
left hand side of every page and selecting Settings from the drop-down
menu.

Microsoft Reader has a Help option where you can find information on how to use the program.
To open Help double tap on Help or, if you are reading a book, tap on the title, then select Help
from the drop-down menu.

DOWNLOADING BOOKS

You can download eBooks either from the Internet or from the memory card after having saved
on them from your PC.

’\‘\5 Note: Microsoft Reader only reads “ lit” files. Always make sure
that you download files of this type.

USING THE LIBRARY

To view the list of books stored either on Myfriend or on the memory card, tap on the Library
button found on the MS Reader toolbar. If you are reading a book, tap on the title and then select
Library from the context menu.

To read a book, tap on itstitle.
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READING AN EBOOK
Tap on Library to open a book: the cover and the first page will appear. The button Go to found
on the left hand side has the following options:

v' Table of Contents - you will find hypertext links. Tap on the desired
chapter to go directly to the corresponding page.

v Most Recent Page — to go to the most recent page visited. Useful
when reading more than one book at the same time.

v' Begin reading

v" Furthest Read — allows you b go to the highest page number you
have read so far.

v' Annotations - it includes all bookmarks, highlighted text and images.

About this title

v' Cover Image - using the Rocker Switch you can skip the table of
contents and start reading the book.
Pl

’Kﬁf'*’ By tapping on the title of the book, you can go back to the cover,
contents, library or change the settings.

<\

In the Go to menu you will find:
v Library, displays the stored book list
v" Shop, allows you to buy books on the Internet
v' Help
v’ Settings
v Return
To browse pages you can:
1. usethe Rocker switch;
2. press on the page number to go to the following page;
3. press on the page number found on the left to go to the previous page;
4

. pressing on the page number, a Slider will appear allowing you to browse
through the pages,

5. the Slider displays the first and last page number. Tap on them to go directly
to these pages. It also displays four small icons around the page number: two
are used to go to the following or previous page, the other two are used to
browse by chapter.
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SETTINGS

Pt
. “'5‘55 Settings selected for one book will be applied to all the others.

The Settings menu has three options:
1. Screen Settings;
2. Notes;
3. Font Settings.

These options can be customised either individually or by tapping on Settings from the drop-
down Help menu.

MS READER FEATURES
Microsoft Reader has different features that cannot be applied when reading a traditional
book.

These features can be selected through a context menu which appears when you highlight the
text by dragging the stylus onit.

ADDING NOTES

To add notes you can:

v select the text (by either double tapping on a single word or dragging the
stylus on it)

v sdect Add text note from the context menu

v' a smal white dialogue box will appear on the page; type in the note
using the Input Panel

v’ then tap anywhere on the page and an icon representing the note will
appear on the left hand side of the page.

Just tap on the icon to view, modify or delete notes.

To delete the note, delete its content and then close the dialogue box. The icon will disappear
confirming that the note has been deleted.

Chapter 7
Microsoft Reader, Page 38



ADDING BOOKMARKS

Adding a bookmark is similar to adding a note:
1. select aword or a sentence
2. sdlect Add bookmark from the context menu

All bookmarks will be found in the Notes menu, you can rename or delete a bookmark by
keeping the stylus pressed on the bookmark: a context menu will open and then you can select the
desired option.

HIGHLIGHTING TEXT

Y ou can highlight parts of the text:
1. select the text by dragging the stylus on the page;
2. select Add highlighting from the context menu.

By default, the selected text will be highlighted in green. To change the colour, select the text to
modify and choose the option Modify highlighting from the context menu. It allows you to either
change the colour or retur n the text to its origina state.

ADDING DRAWINGS

To add adrawing:

1) select the text that you want to attach the drawing
2) select Add drawing from the drop-down menu

3) begin drawing by dragging the stylus on the display.

At the bottom of the page you will see the options DONE, ] and UNDO. With UNDO you
can undo all previous actions one by one; tap DONE to complete the task; with ] you can change
the colour of the design al'so when drawing.

Once you have finished the drawing, tap on Apply and the drawing will be displayed. On the top
right hand side you will see a pencil indicating that there is drawing on the page.
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DELETING DRAWINGS
To delete adrawing:
1. tap on any word of the text;
2. select Edit drawing from the context menu;

3. a the bottom of the page, tap on UNDO until the drawing is deleted.

i

- .--'}\
NE2 To confirm that the drawi ng has been deleted, you will no longer

see the asterisk at the top right hand corner of the page.

Y ou can view the notes by tapping on the title of the book and select Notes from the drop-down
menu. To return to the original page, tap on Back.

FINDING TEXT

To search for atext within the book, tap on Find from the context menu. To look for a new text,

use the Input Panel which appears along with the dialogue box Find. To start searching, tap on
the desired option: the page containing the results of your search will appear, the text will be

highlighted. To close the Find window, tap on the display. To return to the original page, tap on the
title of the book and select Back from the drop-down menu.

COPYING TEXT

This command stores the highlighted text for other applications.

To copy a part of the text from a book and paste it on another program, select the part of the text
you want to copy. Then tap on Copy from the drop-down menu and paste it.

USING THE DICTIONARY

To look up aword in Microsoft Reader dictionary, select the word and then tap on Search
from the context menu: awindow will then appear with a definition.
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APPENDIX A
Troubleshooting

RESET MYFRIEND
If you need to reset the device you can aternatively:
v’ restart it through the reset button;

v activate and deactivate the device using the battery switch found on the
back of the device.

\/—

/A\f\) Caution: deactivating the battery all data will be loss!

.

IF YOU FORGET YOUR PASSWORD
Y ou will have to reset Myfriend moving the battery switch. All datawill be lost.

MEMORY NOT SUFFICIENT

You should delete files that are no longer necessary. Then adjust memory allocation through
Start - Control Panel - System - Memory.

SCREEN DOES NOT TURN ON

Make sure that the device is turned on. If the device is on but the screen still does not work,
connect the device to AC power to check battery status. If this works, the battery may be dead.
Otherwise, try to turn on the device using the battery switch found on the back. If none of these
proves successful, contact customer service.

SCREEN DIFFICULT TO READ

Adjust the back-lighting of the display selecting Start - Settings - Control Panel - Back-
lighting. Move the dider to adjust brightness (4 is the standard), then tap on Apply.

MYFRIEND DOES NOT START
Make sure that the battery switch (#16) is down, otherwise move it using the Stylus.
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THE DEVICE DOES NOT RESPOND PROPERLY TO THE STYLUS

Recdlibrate the display. Select Start - Settings - Control Panel - Stylus - Calibration
Options - Recalibrate, see Stylus for more details.

THE INFRARED CONNECTION (IrDA) DOES NOT WORK PROPERLY

Make sure that both devices have an infrared port and that it is activated, that there are not
interferences between the two devices and they are no more than 30 cm apart. Make sure that
ActiveSync isinstalled on your PC. It this does not work, contact customer service.

THE INTERNET CONNECTION DOES NOT WORK PROPERLY

Make sure that the cable is properly plugged-in. Make sure that you are using an analogue phone
connection.

MAINTENANCE
Use a soft and dry cloth to keep Myfriend clean.

:/fﬁ;g_\
TN Do not use solvents or detergents.
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Appendix B
Regulatory Information

Notice to the European Union users

Myfriend complies with the requirements established by the “European Directive R&TTE
99/05/CE” and conforms to the following product specifications:

v' CEI EN 55022 (1995): regulations on electromagnetic emissions
v' CEI EN 55024 (1999): regulations on electromagnetic immunity
v' CEI EN 60950 (2000): regulations on products’ safety

v' ETSI CTR 21 (1998): regulations on the connections to PSTN

The CE label confirms that the device complies with the basic require-ments of the
R&TTE.

Notification of approval CTR21

This equipment has been approved to Council Decision 98/482/EC for panEuropean single
terminal connection to the public switched telephone network (PSTN). However, due to differences
between the individual PSTNs provided in different countries, the approval does not, of itself, give
an unconditional assurance of successful operation on every PSTN termination point.

In the event of problem, you should contact your equipment supplier in the first instance.

EC Declaration of Conformity
See next page!
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Hersby: IPM- NET S.p.a.
Via Remo De Feo 1 - 80022 ARZANO (NA)
Declares, that the product: MYFRIEND
ol
is in conpliance with the essential requirements and other relevant provisions of the

European Directive listed below:

» Directive 1999/05/EC;

This declaration is based upon compliance of the product to the following standards:

+ EMN 55024;
= EN 60950 ;
« ETSICTR 21 ;

Supplemen
= TEST REPORT EMC Ne568/01 1900901 Globe Communications S.p.a.
+ TEST REPORT SAFETY N® LVD 5T0/01 M0 Globe Communications S.p.a.
« TEST REPORT TLC N® 012571101 050801 Globe Communications 5.p.a.

Arzane, 1211101

. Deldfcubierre
Chigf mical (Mficer

IPHI-NET SpA Direianee, Ui Tel, + 3% 02 6711681 aede Legale ¢ Cipprativi
& Saxcher Arrimiisraiva: Faz +39 02 66713323 BO022 Arran (Mapolil - Wia Bemo De S
Vi Pirell, 32 |'|I‘.|| .. 'v.ln-.'-'||||'|-|'-l {om Tisl, « 32 081 S5F 40 1% . (L] 7wl
MO0 24 Bhilana R, Imjan, SA 144800 2000 T i T, e 1
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USA - Federal Communications Commission (FCC)

Customer Information Part 15
This equipment has been tested and found to comply with the limits for a
"Class B" digital device, pursuant to Part 15 of the FCC rules and meets all
requirements of the Canadian Interference-Causing Equipment Regula-tions.
These limits are designed to provide reasonable protection against
harmful interference in aresidentia installation. This equipment gener-ates,
uses and can radiate radio frequency energy and, if not installed and
used in strict accordance with the instructions, may cause harmful inter-ference
to radio communications. However, there is no warranty that in-terference
will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following
measures:

Reorient or relocate the receiving antenna.

Increase the separation between equipment and the receiver.

Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

Consult the dedler or an experienced radio/TV technician for help.

Customer Information Part 68

This equipment complies with Part 68 of the FCC rules. On the bottom of this equipment is a
label that contains, among other information, the FCC certification number and ringer equivalence
number (REN) for this equipment. If requested, this information must be provided to your
Telephone Company.

This equipment uses the following USOC jacks: RJ11C

An FCC compliant telephone cord and modular plug is provided with this equipment. This
equipment is designed for connection to the telephone network or premises wiring using a
compatible modular jack, which is Part 68 compliant. See Installation Instructions for details.

The REN is useful to determine the quantity of devices that may be connected to the telephone
line. Excessive RENs on the telephone line may result in the devices not ringing in response to an
incoming call. Typically, the sum of RENs should not exceed five (5.0). To be certain of the
number of devices that may be connected to a line (as determined by the total RENS) contact your
local Telephone Company.

If this terminal equipment, MYFRIEND, causes harm to the telephone network, the Telephone
Company will may discontinue your service temporarily. If possible, they will notify you in
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advance. But, if advance notice isn’t practical, the Telephone Company will notify you as soon as
possible. Y ou will be informed of your right to file a complaint with the FCC.

The telephone company may make changes to its facilities, equipment, operations or procedures
that could affect the operation of the equipment. If this happens the Telephone Company will
provide advance notice so you can make the necessary modifications to maintain uninterrupted
service.

If you experience trouble with this telephone equipment, please contact our US service certer
Portnet  Enterprises, Inc, (608)576-6748 (phone) [/ (608)223-0944  (fax) /
service@portnetenterprises.com (e-mail) for information on obtaining service or repair. If the
equipment is causing harm to the telephone network, the Telephone Company may requed that you
disconnect the equipment until the problem is resolved.

There are no user serviceable parts in this equipment.

This equipment may not be used on public coin phone service provided by the Telephone
Company. Connection to party line service is subject to state tariffs. (Contact the state public utility
commission, public service commission or corporation commission for information.)

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a
computer or other electronic device, including fax machines, to send any message unless such
message clearly contains in a margin at the top or bottom of each reansmitted page or on the first
page of the transmission, the date and time it is sent, an identifiction of the business or other entity,
or other individual sending the message, and the telephone number of the sending machine or of
such business, other entity, or individual. (The telephone number provided may not be a 900
number or any other number for which charge exceed local or long-distance transmission charges.)

Battery Caution Statement

et

/‘\?3"5 This device is provided with a set of lithium batteries, that may explode if not
properly replaced. Do not mutilate, puncture, crush, short-circuit, submerge in water or keep
away from heat. For the replacement, contact an authorised IPM-NET service centre.
Batteries must be disposed of properly.

When travelling by plane

Y ou must respect flight companies' regulations when using an electronic device on board.
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Appendix C
Specifications

DISPLAY 7.5" TFT LCD, 65536 colors, 640 x 960 pixel, 150 dpi,
Clear Type compatible in Portrait, resistive touch screen
and back- lighting

PROCESSOR Toshiba MIPS RISC R3000, 129 MHz
MEMORY 32 MB Strata Flash, 64 MB SDRAM
MODEM V.90 56K built-in, on analogue telephone line
AUDIO Built-in microphone
Built-in speaker
Earphone jack
CONNECTION IrDA, USB, RS-232, PCMCIA Typell, Smart Card
PORTS SIM
SOFTWARE Microsoft Windows CE 3.0 operating system, Platform
Builder

Microsoft Reader (Sealed eBooks)
Microsoft Pocket Internet Explorer 4.0 for Windows CE
Microsoft InBox

Microsoft Pocket Word

Odyssey Pocket On-Schedule
IntraNet Solutions Quick View Plus
XAudio MP3 Player

Bsquare Voice Recorder

Bsguare bBackup

Bsquare bFind

WEIGHT 1000 g.
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